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Page Numbering for a Thesis or Dissertation
Tip: Add Page Numbering to your document after you are finished making all edits. After the
page numbering has been added, then add the Table of Contents and/or update the Table of
Contents.
A typical document consist of three main parts:

1. Preliminaries

2. Text (chapters)
3. Supplementaries

The preliminary pages with the exception of the Title page use lowercase Roman numerals,
which are centered and at least ¥2” from the bottom of the page (in the footer).
The text and supplementary pages uses Arabic numerals for page numbering and start with the

page number 1. Page numbers are centered and at least %2” from the bottom of the page (in the
footer).

Title Page:

Per the Graduate School Thesis and Dissertation manual, the cover page should not include any
page numbering.

CopyRight Page:

The Copyright Page is an optional page in the document. The CopyRight page does not use a
page number and is not “counted” in the page numbering.

Abstract Page:

The Abstract Page is the first page in your document that should include a page number. Per the
Graduate School manual, the Abstract page starts with lowercase Roman numeral ii.

Tip: Add page numbering to your document when it is in “final draft” to avoid unnecessary
issues with page numbering.
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Other Preliminary Pages:

All other required and/or optional preliminary pages will use the lowercase Roman numeral and
continue numbering from the previous page(s).

Text Pages:

The text of a thesis/dissertation features an introduction and several chapters, sections, and
subsections. Text pages will use the Arabic numbering and start with Page 1.

How to Add Page Numbering - starting at the Abstract Page
Use the scenario that best fits your document:

Scenario one: document has a Title page and NO copyright page
Step 1:

If your document has a Title page and you do not plan on using a copyright page, then double
click with the mouse in the footer area of your Title page to access the Header/Footer tools:

3

Tip: you could also select the Insert Tab of the Ribbon and choose Insert Page Number to access
the Header/Footer tools.
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Once in the Footer, the Ribbon at the top of the screen should reflect Header/Footer tools:
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- *  HNumber~ | &Time Parts~ Art | Header Foote Link to Previous Show Document Text [ nsert Alignment Tab and Footer
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Select the check box for Different First Page in the Options group of the Header/Footer Tools |
Design tab:

@“ lﬂ Lol (L] ul | = Document2 - Microsoft Word Header & Footer Tools
Home Insert Page Layout References Mailings Review View Developer — Design
[ = B ] ElE 5 Previous Different First Page = Headerfrom Top: 0.5 :
= & & X E ke en b ; x|
— __"—f', Mext [C*Different Odd & Even Pages = [zl Footer from Bottom: 0.5 :
Header Footer Page Date Quick Picture Clip Goto Goto N X Close Header
- *  MNumber~  &Time Parts~ At | Header Footer % Link to Previous Show Document Text [] tnsert Alignment Tab and Footer
Header & Footer Insert Mavigation Options Pasition Close
Click on the Close Header and Footer button to switch out of the footer and move E3

back into the document.

Close Headern
and Footer

Step 2: —

Next, navigate to the Abstract Page and double click with the mouse in the Footer.

From the Header/Footer tools, select the Page Number Icon drop-down list, Bottom of Page, and
the Center option.

This will add a page number of “2” to the Abstract page and leave the Title page without a page
number since we turned on Different First Page.

@“ H ) ~ l_l = Document? - Microsoft Word Header & Footer.Tools
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& Time Parts~ At | Header Footer o= Linkto Previous Show Document Text [ nsert aligr
Header & F Top of Page . MNavigation Options
i

Page Margins » | Plain Number 1

E
[E Bottom of Page F] Simple
=)
(=

Current Position 3

[ Format Page Numbers.., 1
l:}( BRemove Page Mumbers

L Plain Number 2

0 ect Header/Foote
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Colorado State University
Computer Applications Training ©



Step 3:

Format the page number so it displays in lowercase Roman numeral. Start by double clicking
with the mouse in the footer and selecting the page number. Left click the B
mouse and drag it over the page number so that it’s highlighted in “blue”.

Step 4:

Next, from the Header/Footer tools Design tab in the Ribbon, select the drop-down menu for
Page Number, Format Page Numbers.

@' H®-™ & | = Document? - Microsoft Word Header & Footer Tools
Home Insert Page Layout References Mailings Review View Developer Design

=k j ‘:|lq Ellal j‘ _"_ﬂ Previous Different First Page E‘ Header fr
= = s = <
— = QO = Bk 5, Mext [ Different Odd & Even Pages |+ Footer fre
Header Footer Date Quick Picture Clip Go to .
- - & Time Parts - Art Header : Show Document Text ﬂ Insert Alig
Header & F |#=3| Top of Page - Mavigation Options
[§] Eottom of Page ¥ | Simple =
|.,_1 Page Margins » | Plain Number 1
#] Current Position b =
Q‘[ Format Page Numbers...} 1
ﬁ}\ Remove Page Numbers

From the Format Page Number dialog box, select the formatting style for Roman numeral.

2|x] Make sure “continue from previous section” is selected so Word

knows what page number to start with; in this case “ii”.

Mumber format: |1, 2, 3, ...

4

I Include Chalj’*-lrl I S I . .
Tip: if your Abstract page shows a page number of “iii”, then

— double click in your footer, select the page number so that it’s
';E SEF“'I““" blue, navigate back into the Page Number Format dialog box and
e change the Page Numbering option to “start at ii”. If the page
Pa{‘{e numbering — numbering still shows “iii”, then repeat the steps and set page
+ Continue from previous section numberin tO Stal’t at uin.
" Start at: I 5‘ 9
oK I Cancel |
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Result:

Footer

Continue the lowercase Roman numerals for all preliminary pages.

Step 5:

How to Add Arabic Page Numbers to Chapters > text following the preliminary
pages

A Section Break must be added in order to change the page numbering from lowercase Roman
numeral to Arabic page numbers for the remainder of the text.

Tip: section breaks are necessary in a document when margins, page orientation, and
headers/footers need to vary.

Section Breaks are located under the Page Layout tab, Breaks drop-down menu. When adding a
section break, it is best practice to add a “continuous” section break so that it appears more
“transparent” within the text and doesn’t move text to the next page.

= AN N how to add page numbering.doc - Microsoft Waord
Home Insert Page Layout References Mailings Review View Developer
. —_— =l _]
Aaj n Lyy lj l',—_.| Breaks H (Fﬂ)-:] 'ﬁ Indent Sp_
=1 [A]- = age brea eftt 0" a2
Themes Margins Orientation 5ize Columns | Pl
- [@] - - - . Page light: 0" ol /-2
Th Page Set » Mark the point at which one page ends Parac h
EMES dge Jetup ﬁ and the next page begins. dragrap
O R
H ] Column ' ' '
= Indicate that the text following the column
== break will begin in the next column. .
Cor = liminary pages.
Text Wrapping
= Separate text around objects on web
pages, such as caption text from body text.
Section Breaks
HNext Page
[ Insert a section break and start the new
—_— section on the next page.
Continuous
h— Insert a section break%d tart the new
— section on the same paye.
5

Colorado State University
Computer Applications Training ©



Position the cursor at the bottom of the text on the last preliminary page, above the footer. Next,
navigate to the Page Layout tab and click on the Breaks icon, Continuous. This will add a
section break to your document.

Tip: The section break is not “visible” when working in the Print Layout View. The section
break is only visible when working in the Draft view.

Verify the Section Break from the Draft View:

Located in the bottom right corner of the Status Bar, the grey bar at the base of your MS Word
Window, you will see View icons. Click on the Draft icon to view the section break.

IEEE ::l%l 100% (=) [ {+)
Example of Section Break, Continuous, from Draft View
tion Break (Continuous’
I
Switch back to Print Layout view when done viewing; it’s
easier to format your document in Print Layout View. EeEsz= w00 o) 5 @)

Tip: from the Print Layout View, look at the base of the Status Bar, left side. If the “Section”
identifier is turned on to display in the Status Bar, it will show the new section of “2”.

Example of Section identifier turned on from the Print  [(Section: 2 ) Page:6 of6 | Words:920 | G5 | B3 |

Layout View, Left-side of the Status Bar

Customize Status Bar
Formatted Page Mumber vi
Lay S =c If the Section is not displaying in the
P TIOMD 60f6 Status Bar, then right-click with the
Vertical Page Paosition 44"
Layc _ [fthe “Secr] TOUSE ON t_he grey Status Bar and
tg)| | UneNumber 15 | 5o select Section.
Column 33
from|| v | waord Count 943
v | Mumber of Authars Editing
ords: 93
¥ | Spelling and Grammar Check Checking
displ| v | Language e on the greg
 Sec )
v | Signatures Off
v | Information Management Policy Off
v | Permissions Off
Track Changes Off
6
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Step 6:

Once the Continuous Section Break is in place, go to the first page of your text (chapter 1),
which is the page after the last preliminary page in your document.

The first page number in your text and/or chapter 1 must show Arabic page 1. Double click in
the footer to display the header/footer tools.

Example of the footer on first page of your chapter and/or regular text:

@' = s Y how to add page numbering.docx - Microsoft Word
Home Insert Page Layout References Mailings Review View Developer
3 j j '?‘ = ] Els] j‘ j Previous Different First Page E& Header from Top: 0.5 It
- — = =0 _ |—| B [, Mext |:| Different Odd & Even Pages :E:t Footer from Bottom: 0.5 : -

Header Footer Page Date  Quick Picture Clip Goto

e - _ Close Header
=  Mumber~ & Time Parts~ Art Header &= Llink to Previous Show Document Text i] Insert Alignment Tab and Footer

Header & Footer Insert NavTgatan Options Position Close

Step 7:

From the Header & Footer Tools, Design tab, notice the Link to Previous button in the
Navigation Group is turned on or highlighted “orange”.

Click on the Link to Previous icon to turn the linking tool off (the highlight should be off).
Unlinking the two sections is required so that you can vary the formatting from Roman numeral
to Arabic.

Step 8:

Next, highlight the Roman numeral page number and delete it.

(@ ]

[First Page Fc{}\%&r -Section 2- J

Step 9:

Next, from the Header/Footer Tools Design tab, click on the Page Number icon drop-down
menu. Select Bottom of Page, Plain Number 2, Center.
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Insert Page Layout References Mailings Review
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Step 10:

E \l;l Iﬁ‘ %% E ;:r:ious
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& Time Parts~ Art Header Footer o Link to Previous

Different First Page
[[7] Different Odd & Even Pages
Show Document Text

Options

Design

E

Bottom of Page ] 4 Simple

E EfE

=

Page Margins » | Plain Number 1

Current Pasition b

Format Page Mumbers... i

Remove Page Numbers

Plain Number 2
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Next, format the page number to show Arabic.

Select the page number, right-click on it and choose Format Page

Numbers

From the Page Number Format dialog box, set the following options:

Page Number Format

2| x|

MNumber format: |1, 2, 3, ..

-

Number Format: choose 1,2,3 (Arabic)
Start At: select 1

Click on the OK button.

™ Indude chaptd= m—— =
a b, o, ..
Chapter startds g ¢, ... -
iy iy i, il
Use separator? - owPEm T
Examples: 1-1, 1-A

Eage numbering =
Continue from previous section

lﬁ' Start at: |1 5‘ I

oK I Cancel |

The Arabic Page numbing should continue through the rest of the document.
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Tip: if when you close your footer and the page number starts
with a “2” instead of a “1”, then format the page number again

to start at “0”.

FasLs U U S,

=

Update Field
Edit Field..,

Toggle Field Codes

Font...

[ﬁ} Format Page Numbers...%
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Scenario two: document has a Title page and a Copyright page

If a document has a Title page and a Copyright page, then page numbering should start on the
Abstract page with lowercase Roman numeral ii.

NOTE: all the step by step instructions on how to insert a section break, unlink sections, insert
page numbering, and format page numbering is listed above in scenario one. The steps listed for
scenario two aren’t detailed. Please review the topic areas above if you need detailed
instructions on the tools mentioned below.

The Title page and the Copyright page do not display page numbering. Also, the Copyright page

is not included in the page count for the document. The Abstract page is the first page to show a
page number and it should start with lowercase Roman numeral ii.

Step A:

Add a Section Break Continuous to the base of the Copyright page.

= AN N how to add page numbering.docx - Microsoft Ward

Home Insert Page Layout References Mailings Review View Developer

- — l -l =l

j n Ly lj h= Breaks ﬁ (F))—:] m Indent Sp_
=1 [A]- = age brea eftt 0" a2
Themes Margins Orientation 5ize Columns | Pl
- [@] - - - . Page light: 0" ol /-2
Th Page Set » Mark the point at which one page ends Parac h
EMES dge Jetup ﬁ and the next page begins. dragrap
O R

= T T T

o Column
J = Indicate that the text following the column
==
Y
e

break will begin in the next column. .
liminary pages.

Text Wrapping

Separate text around objects on web

pages, such as caption text from body text.

Section Breaks

HNext Page
Insert a section break and start the new
section on the next page.

Wil

Continuous
Insert a section break%d tart the new
section on the same paye.

Y
I
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Step B:

Next, navigate to the footer of the Abstract page, click in the footer and unlink the sections.
Click on the Link to Previous to turn it off.

@“ lg - 15 ,‘l |: how to add page numbering.docx - Microsoft Word Header & Footer Tools

Home Insert Page Layout References Mailings Review View Developer | Design
=h T I 5 — ElE= (5 Previous Different First Page {5+ Header from Top: 0.5 : E
= = E -—«11 = |
=l = = = EE) 5T}, Mext [[] pifferent Odd & Even Pages | [z} Footer from Bottom: 0.5 +

Header Footer Page Date Quick Picture Clip Goto Gotof== Close Header
- =  Number~ &Time Parts~+ Art Header Foote 23 Link to Previous Show Document Text ,ﬂ Insert Alignment Tab and Footer
Header & Footer Insert T COptions Position Close

Next, from the Page Number drop down list of the Header and Footer Design tools, select the
Bottom of the Page, Center, to add the page numbering.

Home Insert Page Layout References Mailings Review View Developer ‘— Design
=N L E H u ElE 5, Previous Different First Page g
= — = ; |’_‘ﬂ| DD - __C'T, MNext [ Different 0dd & Even Pages | |
Hea-der Fm:ter B?Taﬁ;e %L#:E Ficture i:f: HGE‘;;?" :_: 22 Link to Previous Show Document Text 1
Header & F [®  Top of Page » Mavigation Options
m [;5] Bottom of Page ] b Simple e I
I ﬂ Page Margins » | Plain Number 1
#]  Current Position 3 =
,ﬁi‘ Format Page Numbers... i
& Remowe Page Numbers
1_ Plain Number 2 [—

Plain Mumbear 3

Step D:

Next, format the page numbering to start at lowercase Roman numeral. Select the page number
in the footer and right-click your mouse, choose Format Page Numbers.

Ey s wpusi.

| =
2" update Field
Edit Field...

Toggle Field Codes

[ﬁ‘ Format Page Numbers...%

A Font.
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From the Format Page Number dialog box, select the formatting style for Roman numeral.

21| Make sure Start At is set to lowercase Roman numeral ii.

Number format:

-] Tip: if your Abstract page shows a page number of “iii”, then

[™ Indude chapts _1r ' - - . . .
double click in your footer, select the page number so that it’s

i, blue, navigate back into the Page Number Format dialog box and
;'E Ser“'l“t"" change the Page Numbering option to “start at ii”. If the page
o numbering still shows “iii”, then repeat the steps and set page

e — numbering to start at “i”.
[ Continue from previous section
" Start at: | 5‘
oK I Cancel |
Result:

Footer

ii

|

Continue the lowercase Roman numerals for all preliminary pages.
Step E and F:
Next, add a section break continuous to the last page of the preliminary pages.

Navigate to the first text page (chapter 1) and turn and double click in the footer. Turn off the
Link to Previous.

@I H Lefo __L |= how to add page numbering.doox - Microsoft Word Header & Footer Tools
Home Insert Page Layout References Mailings Review View Developer | Design
j j j & El=l j‘ j Previous Different First Page 3& Header from Top: 0.5 :
= = i =T = . N
- = = o = — 5 Next [[] Different Odd & Even Pages | fzj+ Footer from Bottom: 0.5" : -
Header Footer Page Date Quick Picture Clip Goto mE. .. - . X Close Header
- - Mumber~ | & Time Parts~ At Header k%ff:;Llnkto Previous Show Document Text j] Insert Alignment Tab and Footer
Header & Footer Insert Navganan Options Pasition Close
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Step G:

Ead
T

Next, select the page number listed and delete it.

Step H:

Add the new Arabic page numbering. Select the Page Number icon, Bottom of Page Plain
Number, Center.

Home Insert Page Layout References Mailings Review View Developer | Design
" B " E
= j ':|5_ = [F ElE j‘ 5, Previous Different First Page i
=| = [I%E =| | EE] ’ ) [
_"_f',Next [C] Different Odd & Even Pages £
Header Footer Date Quick Picture Clip Goto = .
- - & Time Parts~ Art Header Footer &= Linkto Previous Show Document Text
Header 8 F Ig Top of Page . Mavigation COptions
E (g] Bottom of Page } 3 Simple Al
I I,,_’I Page Margins » | Plain Number 1
#]  Current Position b =
Q} Format Page Mumbers... i
y
X

Remove Page Numbers

Plain Number 2 —

Plain Mumhar 3

Step I:
Last, format the page number to show Arabic.
Select the page number, right-click on it and choose Format Page Numbers

From the Page Number Format dialog box, set the following options:

Number format: |1, 2,3, . ~  Number Format: choose 1,2,3 (Arabic)
™ Indude chapts -] Start At: select 1
Chapter st ta'b'c""
Naprer star — .
. A B G -| Click on the OK button.
Ise separatort——— | T |
Examples: 1-1, 1-A

Tip: if when you close your footer and the page number starts
Eaﬂe numbering I with a “2” instead of a “1”, then format the page number again
Continue from previous section

l" S = | to start at “0”.

The Arabic Page numbing should continue through the rest of
x |lea | e document
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